
https://support.industry.siemens.com/cs/ww/en/view/84061788

Application description  09/2015

PCS 7 Unit Template "Polymerization
Reactor" using the example of the
Chemical Industry
SIMATIC PCS 7

https://support.industry.siemens.com/cs/ww/en/view/84061788


Warranty and liability

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 2

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

Warranty and liability

Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
Application examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Security
informa-
tion

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, solutions, machines, equipment and/or
networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.

For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept.  Third-party
products that may be in use should also be considered.  For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit
http://support.industry.siemens.com.

http://www.siemens.com/industrialsecurity
http://support.industry.siemens.com/
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1 Task and solution
1.1 Task

The standardization of automation engineering for processing plants, such as
in the chemical industry, is a major challenge. Different process steps and
procedures, different equipment and flexibility in the production make the task
even more difficult.
This includes the configuring of the plant according to the physical model of the
ISA 106 standard. This specifies the lower four levels, i.e. plant, unit, plant unit and
control module. A plant always consists of units. The units can, in turn, comprise
plant units which can be automated by equipment modules.

1.2 Solution

1.2.1 Unit Polymerization reactor

A polymerization reactor is an integral part of many chemical processes.
Polymerization reactors can be designed for continuous as well as discontinuous
operation with different volumes. The selection of a specific reactor is based on
typical specifications which include:
 Production volume and polymer formation
 Reaction rates, aggregate states of monomers, comonomers and polymers
 Viscosity, thermal stability

This application example contains a polymerization reactor with circulation cooling
for continuous operation.
During the manufacturing process of polymers, the monomer, comonomer,
hydrogen reactants as well as the catalyst and cocatalyst, among others, are
added and stirred in the reactor. The use of an MPC control (Model Predictive
Control), improves the quality of the manufacturing process or the product.

1.2.2 Description of the complete solution

The unit template "polymerization reactor" contains pre-made, standardized and
ready-interconnected equipment modules and process tag types. Using
this sample solution as a basis, numerous instances with different parameter
assignments can be generated with adapted characteristics to be widely integrated
in automation solutions. The PCS 7 project is configured to be hardware-
independent and can be flexibly incorporated in existing projects.
The unit template "polymerization reactor" has been implemented as a PCS 7
multiproject as follows:
• One project for the automation system (AS) and one project for the operator
station (OS) are respectively contained in the component view.
• A hierarchy folder has been set up in the technical hierarchy for each technical
function of the polymerization reactor.
In the AS project, all open- and closed-loop control functions are implemented in
the form of CFC (Continuous Function Chart) charts. Furthermore, the AS project
also contains a hierarchy folder with simulation charts that simulate a procedure,
e.g. the filling level change, within a technical function.
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All equipment modules are available in the project's master data library as process
tag types and contain function blocks of the PCS 7 Advanced Process Library
(APL) and of the Industry Library (IL).
The OS project comprises the visualization of the polymerization reactor with all
equipment modules and shows:
• A schematic structure of a polymerization reactor
• The relevant parameters (KPI: Key Performance Indicators)
• The procedural control of a continuous production process

Differentiation
This automation solution is designed for a polymerization reactor in the continuous
or semi-continuous operation. During semi-continuous operation different sorts
(Grades) of a polymer are alternately produced in a reactor. The grade change
requires a change in the reaction conditions during the running process. The
automation of the grade change is a particularly challenging technical control task.
The unit template could also be adapted for batch operation. In batch operation,
the specifications for the quantities of raw materials and the product discharge are
done through a recipe control. However, it should be checked whether non-
linearities of the process dynamics require special adaptations to the regulatory
approach, especially for the start-up phase of the reaction.
In the template, the technical process within the polymerization reactor is only
simulated as a much simplified and linearized process. After the simulation has
been extended, the unit template could also be used within the framework of an
operator training system.

 Required experience
Fundamental knowledge of the following specialist fields is a prerequisite:
 Engineering with SIMATIC PCS 7 and APL
 Knowledge of control technology
 Basic knowledge of process technology
 An understanding of the concept of the equipment modules
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1.2.3 Core functionality

The individual parts of a polymerization reactor are described in the following.
The entry point is the process picture of the visualization screen.

Figure 1–1:

Process diagram
The process picture of a polymerization reactor consists of the following parts:
 A schematic representation of the unit, with input (arranged on the left) and

output (arranged on the right) materials
 Graphic modules for controlling the individual components (units)
 SFC for the start and production operation
 Overview of the relevant parameters (Key Performance Indicators) and

operating hours display
In the process picture, the operator is provided with an overview of the unit and can
carry out the necessary operator intervention.
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1.2.4 Description of the individual functions

Figure 1–2
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The process picture of a polymerization reactor consists of the following main
parts:
1. Inflow of input materials (educts)
2. Level control over product outflow
3. Temperature control (jacket and reactor internal temperature)
4. Pressure control
5. Mixers
6. Polymerization reactor

(1) Inflow of input materials (educts)
The input materials are added to the vessel via the inflow and in the defined flow
volume. Different control concepts are used for flow control. These include:
 Ratio control
 Standard control
 Multivariable control for the presetting of educt inflow setpoint values as

downstream controls

(2) Level control over product outflow
The flow volume of the outflowing product depends on the fill level of the
polymerization reactor and is controlled in a way that the reactor's fill level remains
constant. Whenever there's a fill level change (due to a difference between the
inflowing and outflowing volumes) the controller reacts to the fill level changes
and compensates them by lowering or increasing the outflow volume.
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(3) Temperature control (jacket and product temperature)
For the chemical reactions to take place it is required to have the correct
temperature of the materials in the reactor (vessel). Due to the temperature
dependency of the reaction speed and the exothermic or endothermic chemical
reactions, reactor temperature control is a very demanding task. This requirement
is fulfilled by using a stirred tank reactor with jacket cooling. The required reaction
temperature or reaction environment is preset via the vessel jacket. In order to
dissipate the reaction heat of the highly exothermic polymerization, a part of the
reactor contents is also pumped through an external heat exchanger. This pumped
circulation is necessary, since the heat dissipated from the wall between the
reactor and the cooling jacket alone is not sufficient.
Rapid cooling (through an exothermic reaction) of the reaction mass is done by
channeling cooling water as a service medium through the heat exchanger, which
removes the reaction heat formed by the reaction. In endothermic reactions, the
heat of the reaction mass has to be accordingly supplied (not considered in this
project).
To reach the preset jacket temperature, the vessel's jacket temperature is
controlled with heating steam or cooling water. The vessel jacket influences the
temperature inside the reactor with a small lag.

(4) Pressure control
The proper pressure within the vessel and an optimal composition of the gas phase
for the reaction in the reactor are required for chemical reactions to take place.
To fulfill this requirement, a preset vessel pressure is set via the pressure control
and kept constant as much as possible. To increase the pressure, nitrogen is
added via a supply line as an inert gas that doesn't participate in the chemical
reaction. To reduce the pressure, an outlet valve is opened, thus allowing the gas
mixture to escape from the container.
This type of control is called split range control and it can also be used for other
tasks, independent from the reactor, where two actuators should controlled by
the controller (e.g. temperature control with separate actuators for heating and
cooling).

 (5) Mixers
The motorized mixer has the task of mixing the added educts or components
together and to form a uniform distribution of the material concentration and
temperature within the reactor. To avoid damage to the mixer, the mixer must
be disabled if the level falls under a certain limit.

(6) Polymerization reactor
Chemical reactions take place in the polymerization reactor. The selection and
design of the reactor is done while taking account of procedural contexts, part of
which can be very complex.
These include:
 Reaction mixtures that require a special frame size or vessel properties
 Inflow and outflow volumes to determine the reactor size
 Reaction sequence in the necessary environmental requirements

(temperature, pressure, mixing)
The concentration of various substances in the reactor and the melt flow index of
the polymer are also recorded and used for flow rate and temperature control.
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Parameters (KPI: Key Performance Indicators)
The key performance indicators are measured or calculated:
 Dwell time
 Space-time yield
 Catalyst productivity

Operating hours counter
The process picture contains the following operating hours counters:
 Motor of the mixer
 Pump for diluent (educt)
 Pump for cooling/heating medium of the vessel jacket
 Pump for cooling/heating medium of the heat exchanger

1.2.5 Control concept

A multivariable control (MPC) is used to control the concentration of the gaseous
materials in the reactor and the product quality (melt flow index of the polymer)
by taking over setpoint value specifications for the inflows (comonomer, hydrogen,
catalyst) during the process.
If measurable disturbances occur in the system, and the process is significantly
influenced, these can be used for the feedforward control.
For the subordinate controllers, the PID controller "PIDConL" of the APL is
employed for the flow rate of the comonomer, the hydrogen and the catalyst.
All other controllers are also equipped with PID controllers, however they are
designed as standard, split range, cascade or ratio controllers.
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1.2.6 Piping and instrumentation diagram

The following figure shows the individual elements of the polymerization reactor in
a piping and instrumentation diagramm.

Figure 1–3
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1.3 Hardware and software components

1.3.1 Scope

This application applies to
 SIMATIC PCS 7 V8.0 SP1
 SIMATIC PCS 7 V8.1 SP1

1.3.2 Components used

Hardware components
Table 1–1

Component Note
SIMATIC PCS 7 ES/OS IPC547D W7 For the PCS 7 V8.0 SP1 sample project
SIMATIC PCS 7 ES/OS IPC647D For the PCS 7 V8.1 SP1 sample project

Note In case of different hardware, please take heed of the minimum requirements for
installing the software components. The minimum requirements can be found in
the Read Me file of the PCS 7.

Standard software components
Table 1–2

Component Note
S7-PLCSIM License is not a part of SIMATIC PCS 7 ES/OS
APG library License is not a part of SIMATIC PCS 7



1 Task and solution
1.3 Hardware and software components

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 12

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

Samples files and projects
Table 1–3

Component Note
84061788_PolyReactor_DOC_en.pdf This document
84061788_PolyReactor_PCS7V801.zip PCS 7 V8.0 SP1 example project
84061788_PolyReactor_APG_PCS7V801.zip PCS 7 V8.0 SP1 example project with

APG process pictures
84061788_PolyReactor_APG_PCS7V811.zip PCS 7 V8.1 SP1 example project with

APG process pictures

Note The PCS 7 example project is based on the PCS 7 Industry Library (IL) and the
PCS 7 Advanced Process Library (APL). Whereas the APL is covered by the
SIMATIC PCS 7 Engineering license, you must obtain a separate Engineering
license and Runtime licenses for IL.

The download contains the block "SimAn", which requires a license. The usage
of this block in your configuration environment or in the process mode obligates
you to purchase the PCS 7 Industry Library licenses.

Ordering information can be found under the following entry ID:

104206476 (PCS 7 Advanced Process Graphics V8.1)
74789158   (PCS 7 Advanced Process Graphics V8.0)
104206371 (PCS 7 Industry Library V8.1)
68376061   (PCS 7 Industry Library V8.0)

https://support.industry.siemens.com/cs/ww/en/view/104206476
https://support.industry.siemens.com/cs/ww/en/view/74789158
https://support.industry.siemens.com/cs/ww/en/view/104206371
https://support.industry.siemens.com/cs/ww/en/view/68376061
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2 Basic principles
2.1 Polymerization

Polymerization is a chemical reaction in which the same or different molecules
(also called monomers) combine to form a chain, the so called polymers.
The reaction is initiated by radicals. The unsaturated monomers attach themselves
to the chain until it has reached the desired length and possibly also network.
The catalysts used are mostly correspondingly targeted at the reaction control.
The following educts are typically used for the production of polymers: Monomers
(in the example of ethane: C2), comonomers (in the example of butane: C4),
hydrogen (H2 all gaseous) as well as the catalyst and cocatalyst (solids).

Synthetic polymers based on carbon:
 Polyethylene (PE)
 Polypropylene (PP)
 Polyketone (PK)
 Polyvinyl chloride (PVC)

Synthetic polymers with other bases:
 Silicones, particularly poly(organo)siloxanes
 Melamine resin

Biopolymers:
 Proteins such as enzymes, hair, silk,
 DNA (the genetic material)
 RNA
 Carbohydrates such as cellulose, wood, paper, starch, chitin
 Polyhydroxyalkanoates, the biopolyester as an energy and carbon storage of

bacteria

2.2 Melt flow index (MFI, MFR)

The melt flow index (MFI = Melt Flow Index, or MFR = Melt Flow Rate )
describes  the fluidity (viscosity) of a material/materials, such as polymer melt and
is expressed in weight per 10 minutes (g/10 min). This flow behavior applies to
certain pressure and temperature conditions. The melt flow index is related to
the length of the polymer chains and is thus indirectly a measure for other polymer
properties such as density and hardness.
A fixed MFI of the finished good is usually preset as a specification for a particular
polymer. Excessive deviation means an insufficient quality.
Alternatively, it is also possible to define a melt volume-flow rate (MVR = Melt
Volume Rate, MVI = Melt Volume Index). This is expressed in volume per
10 minutes (cm³/10 min).
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3 Design and principle of operation
3.1 Project structure

3.1.1 CFC structure

A uniform naming convention is used for identifying the measurement points,
whereby the function has been named according to the European standard
EN 62424. The following figure shows the composition of a measurement point
name:
Figure 3–1

TIC_Jacket

Function
T = temperature (first letter)
I = indication (subsequent letter)
C = control (subsequent letter)

Designation

The following table contains all letters used in the application their meanings:
Table 3-1

First letter Meaning

F Flow
L Level
M Moisture
N Motor
P Pressure
Q Amount, quantity or quality
C Speed (velocity, rotational speed, frequency)
T Temperature
X Freely selectable first letter
Y Control valve

Table 3-2

Subsequent
letter

Meaning

C Control
F Fraction
I Indication
C Binary control function or switching function (not safety-oriented)

("switching")

3.1.2 Plant view

The unit template "Polymerization Reactor" is implemented in the plant view in two
hierarchy levels.
In the AS project, the first hierarchy level is empty and in the subordinate hierarchy
level there is only respectively one hierarchy folder, with the necessary CFC charts
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and the associated process simulation ("Sim_*" charts), for each technical function
(functional unit) of the polymerization reactor. The simulation can be removed for
use in a real plant.
The first hierarchy level of the OS project is also empty. The process picture
"PolyReactor.pdl" of the polymerization reactor is located in the subordinate
hierarchy folder.
The following figure depicts the PCS 7 multiproject structure.
Figure 3–2
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3.2 Equipment modules and process tags

The unit template "Polymerization Reactor" consists of pre-made equipment
modules and additional CFC charts, e.g. for process simulation. In a PCS 7 project,
all process tags – such as of the equipment modules – are based on process tag
types from the master data library. You will find the application description
"Equipment Modules for PCS 7 using the example of the Chemical Industry" and
the example projects with the individual equipment modules and process tag types
under the entry ID: 53843373.
The application example contains the following elements:
 Educt addition (Feed): Feed control of the individual educts and catalysts
 Level control (Level): Level control of the discharge
 Jacket temperature control (JacketTemp): Control of the jacket temperature
 Product temperature control (Cooling): Control of the reactor internal

temperature
 Pressure control (Pressure): Control of the tank pressure
 Mixing (Agitation): Mixing of the product
 Material concentrations and melt flow index (polymer)
 Sequencer (SFC) for starting up the polymerization reactor
 Overarching process simulation (Simulation)
 Process parameters (KPI)

In the following sections you will find the setup of the specific equipment modules
as well as the extension and modifications made vis-à-vis the original equipment
modules measurement point types. In addition, the SFC for starting up the
polymerization reactor is documented.

Note All necessary descriptions, configurations and procedures pertaining to the
reference versions can be found in the documentation under the entry ID:
53843373. You will find the information on the specific equipment modules in
Chapter 5 "Equipment Modules" and on the measurement point types in
Chapter 4 "Individual Control Level".

https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/53843373
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3.3 Educt addition (feed)

The total inflow is composed of various solid or gaseous educts. The inflow control
is performed by a multivariable controller process tag (material concentration), a
ratio control and a standard flow control with fixed setpoint value specifications
through the step sequencer.

Design

Inflow of the cocatalyst via flow control
The flow control (PID control) for the cocatalyst gets its setpoint value from the
SFC. As with the monomer, the cocatalyst receives a fixed setpoint value for
the production.
The following table provides you with an overview of the elements and
measurement point types used.

Table 3–3

Name Process tag type Description

FIC_Cocatalyst "CTRL_Std4Valve" Flow control of the cocatalyst, setpoint value from the SFC
YC_Cocatalyst "Val_An_Afb1" Control valve for "FIC_Cocatalyst"

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3–3
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Inflow via ratio control
Two inflows are realized with the "Ratio-Control" technical function. This includes
the main monomer educt to which the other diluent educt is added in a specified
(stoichiometrically meaningful) value.
The following table provides you with an overview of the elements.

Table 3–4

Name Technical function /
process tag type

Description

FIC_Monomer "Ratio-Control" Flow control of the main components
YC_Monomer "Ratio-Control" Control valve for "FIC_Monomer"
FFIC_Diluent "Ratio-Control" Ratio control of the secondary component in relation

to the main component
YC_Diluent "Ratio-Control" Control valve for "FFIC_Diluent"
NS_PumpDiluent "MOT_1sp_1fb_1cm__Std" Pump for diluent
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In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3–4
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Inflow via multivariable control
The multivariable control "XC_Polymer" controls the reaction conditions
(concentration of gases in the reactor) as well as the quality of the polymers.
To achieve this, the controller detects the concentrations of the components C2,
C4 and H2 and delivers its manipulated variables as external setpoint values
to the slave controllers "FIC_Catalyst" "FIC_Hydrogen" and "FIC_Comonomer".
The multivariable controller also gives a setpoint value for the reactor temperature,
see section 3.9.
The following table provides you with an overview of the elements.

Table 3–5

Name Process tag type Description

FIC_Catalyst "CTRL_Std4MPC" Flow controller for catalyst, actuated by the MPC
YC_Catalyst "Val_An_Afb1" Control valve for "FIC_Catalyst"
FIC_Hydrogen "CTRL_Std4MPC" Flow controller for hydrogen, actuated by the MPC
YC_Hydrogen "Val_An_Afb1" Control valve for "FIC_Hydrogen"
FIC_Comonomer "CTRL_Std4MPC" Flow controller for comonomer, actuated by the MPC
YC_Comonomer "Val_An_Afb1" Control valve for "FIC_Comonomer"
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In the following figure, the structure of the flow controller including all the cross-
chart interconnection is depicted in simplified form.
Figure 3–5
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Simulation
The simulation chart "Sim_Feed" provides simulations of the time lag, the process
gain and the flow scaling for all inflows.
Figure 3–6

1 2 3
4

1. Time lag in seconds "Lag_xxxxx", which is caused by the inertia of the actuator
and also by the time constant of the flow sensor (incl. low-pass filter in the
measuring instrument).

2. The "Gain_xxxx" factor defines the process gain.
3. The "Feed_xxxx" factor defines the scaling or the flow volume of the educts.
4. Summation of all inflows.

Parameter assignment

FIC_Catalyst
The following table shows the configuration of the instance from "CTRL_Std4MPC".
Table 3-6

Module Connection Value Usage

C Gain 13.5 Controller gain
C TI 1.8 Controller lag
C SP_InHiLim 50.0 Maximum value of the internal setpoint
C PropFacSP 0.5 P-action in feedback loop

to_MPC Out

Interconnection for the multivariable
controller
(XC_Polymer\from_CTRL_3.In)

to_Valve Out
Interconnection for the valve (control)
(YC_Catalyst\from_CTRL.In)

from_Valve In
Interconnection for the valve (status)
(YC_Catalyst\to_CTRL.Out)

Sim Sim1ActOp.Value 1 Activate the simulation values

Sim Sim1ValueOp
Interconnection for the simulated
process value
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Module Connection Value Usage
(Sim_Feed\Gain_Catalyst.Out)

PV Scale 150.0 Maximum value of the process value
PV PV_InUnit 1324 Unit of the process value (kg/h)

FIC_Hydrogen
The following table shows the configuration of the instance from "CTRL_Std4MPC".
Table 3-7

Module Connection Value Usage

C Gain 22.5 Controller gain
C TI 1.4 Controller lag
C SP_InHiLim 50.0 Maximum value of the internal setpoint
C PropFacSP 0.5 P-action in feedback loop

to_MPC Out

Interconnection for the multivariable
controller
(XC_Polymer\from_CTRL_2.In)

to_Valve Out
Interconnection for the valve (control)
(YC_Hydrogen\from_CTRL.In)

from_Valve In
Interconnection for the valve (status)
(YC_Hydrogen\to_CTRL.Out)

Sim Sim1ActOp.Value 1 Activate the simulation values

Sim Sim1ValueOp

Interconnection for the simulated
process value
(Sim_Feed\Gain_Hydrogen.Out)

PV Scale 120.0 Maximum value of the process value
PV PV_InUnit 1349 Unit of the process value (m3/h)

FIC_Comonomer
The following table shows the configuration of the instance from "CTRL_Std4MPC".
Table 3-8

Module Connection Value Usage

C Gain 5.29 Controller gain
C TI 5.372 Controller lag
C SP_InHiLim 180.0 Maximum value of the internal setpoint
C PropFacSP 0.5 P-action in feedback loop

to_MPC Out

Interconnection for the multivariable
controller
(XC_Polymer\from_CTRL_1.In)

to_Valve Out
Interconnection for the valve (control)
(YC_Comonomer\from_CTRL.In)

from_Valve In
Interconnection for the valve (status)
(YC_Comonomer\to_CTRL.Out)

Sim Sim1ActOp.Value 1 Activate the simulation values

Sim Sim1ValueOp

Interconnection for the simulated
process value
(Sim_Feed\Gain_Comonomer.Out)
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Module Connection Value Usage

PV Scale 500.0 Maximum value of the process value
PV PV_InUnit 1324 Unit of the process value (kg/h)

FIC_Monomer
The process tag has the following different configuration when compared to the
ratio control.
Table 3-9

Module Connection Value Usage

C Gain 0.618 Controller gain
C TI 7.211 Controller lag
C SP_InHiLim 8000.0 Maximum value of the internal setpoint

Sim Sim1ValueOp

Interconnection for the simulated
process value
(Sim_Feed\Gain_Monomer.Out)

PV Scale 8000.0 Maximum value of the process value
PV PV_InUnit 1324 Unit of the process value (kg/h)

FFIC_Diluent
The process tag has the following different configuration when compared to the
ratio control.
Table 3-10

Module Connection Value Usage

C Gain 0.2 Controller gain
C TI 1.0 Controller lag
C SP_InHiLim 150.0 Maximum value of the internal setpoint
Ratio RatioInt 0.01 Internal ratio value
Ratio RatioExt 0.007105 External ratio value
Ratio RatHiLim 1.0 Upper ratio value
Ratio RatioOpScale 1.0 Scaling of the ratio value for the operator
Ratio OutHiLim 150.0 Upper limit value for the output value

Sim Sim1ValueOp

Interconnection for the simulated
process value
(Sim_Feed\Gain_Diluent.Out)

PV Scale 150.0 Maximum value of the process value
PV PV_InUnit 1349 Unit of the process value (m3/h)
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FIC_Cocatalyst
The following table shows the configuration of the instance from "CTRL_Std4Valve".
Table 3-11

Module Connection Value Usage

C Gain 23.0 Controller gain
C TI 9.0 Controller lag
C SP_InHiLim 4.0 Maximum value of the internal setpoint

to_Valve Out
Interconnection for the valve (control)
(YC_Cocatalyst\from_CTRL.In)

from_Val
ve In

Interconnection for the valve (status)
(YC_Cocatalyst\to_CTRL.Out)

Sim
Sim1ActOp.
Value 1 Activate the simulation values

Sim
Sim1ValueO
p

Interconnection for the simulated
process value
(Sim_Feed\Gain_Cocatalyst.Out)

PV Scale 4.0 Maximum value of the process value
PV PV_InUnit 1324 Unit of the process value (kg/h)

YC_Catalyst
The valve measurement point "YC_Catalyst" controls the flow volume (opening
of the feed input) to the vessel. The measurement point contains communications
modules for data exchange (control signals and control commands) with the
controller measurement point.
The valve module "V" contains an external manipulated variable (through
a communications module) from the controller measurement point. In a simulation
environment, both channel modules in chart partition "B" (Rbk and MV) receive
the same value (manipulated variable of the valve module (chart partition "A",
sheet 1)) through the primary simulation module, i.e. a lag between valve actuation
and valve movement is not simulated.
The following table shows the configuration of the instance from "Val_An_Afb1".
Table 3-12

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Feed\Lag_Catalyst.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

from_CTRL In
Interconnection for the controller
(FIC_Catalyst\to_Valve.Out)

to_CTRL Out
Interconnection for the controller
(FIC_Catalyst\from_Valve.In)

Sim Sim1ActOp.Value 1
Activate simulation of the read-back
value

Sim Sim1ValueOp

Interconnected with the simulation of
the read-back value from the valve
(YC_Catalyst\V.MV)
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Module Connection Value Usage

Sim Sim2ActOp.Value 1
Activate simulation of the manipulated
variable

Sim Sim2ValueOp

Interconnection with the simulation of
the manipulated variable from the valve
(YC_Catalyst\V.MV)

YC_Hydrogen
The valve measurement point "YC_Hydrogen" controls the flow volume (opening
of the feed input) to the vessel. The measurement point contains communications
modules for data exchange (control signals and control commands) with the
controller measurement point.
The valve module "V" contains an external manipulated variable (through
a communications module) from the controller measurement point. In a simulation
environment, both channel modules in chart partition "B" (Rbk and MV) receive
the same value (manipulated variable of the valve module (chart partition "A",
sheet 1)) through the primary simulation module, i.e. a lag between valve actuation
and valve movement is not simulated.
The following table shows the configuration of the instance from "Val_An_Afb1".
Table 3-13

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Feed\Lag_Hydrogen.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

from_CTRL In
Interconnection for the controller
(FIC_Hydrogen\to_Valve.Out)

to_CTRL Out
Interconnection for the controller
(FIC_Hydrogen\from_Valve.In)

Sim Sim1ActOp.Value 1
Activate simulation of the read-back
value

Sim Sim1ValueOp

Interconnected with the simulation of
the read-back value from the valve
(YC_Hydrogen\V.MV)

Sim Sim2ActOp.Value 1
Activate simulation of the manipulated
variable

Sim Sim2ValueOp

Interconnection with the simulation of
the manipulated variable from the valve
(YC_Hydrogen\V.MV)

YC_Comonomer
The valve measurement point "YC_Comonomer" controls the flow volume (opening
of the feed input) to the vessel. The measurement point contains communications
modules for data exchange (control signals and control commands) with the
controller measurement point.
The valve module "V" contains an external manipulated variable (through
a communications module) from the controller measurement point. In a simulation
environment, both channel modules in chart partition "B" (Rbk and MV) receive
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the same value (manipulated variable of the valve module (chart partition "A",
sheet 1)) through the primary simulation module, i.e. a lag between valve actuation
and valve movement is not simulated.
The following table shows the configuration of the instance from "Val_An_Afb1".
Table 3-14

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Feed\Lag_Comonomer.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

from_CTRL In
Interconnection for the controller
(FIC_Comonomer\to_Valve.Out)

to_CTRL Out
Interconnection for the controller
(FIC_Comonomer\from_Valve.In)

Sim Sim1ActOp.Value 1
Activate simulation of the read-back
value

Sim Sim1ValueOp

Interconnected with the simulation of
the read-back value from the valve
(YC_Comonomer\V.MV)

Sim Sim2ActOp.Value 1
Activate simulation of the manipulated
variable

Sim Sim2ValueOp

Interconnection with the simulation of
the manipulated variable from the valve
(YC_Comonomer\V.MV)

YC_Monomer
The process tag has the following different configuration when compared to the
ratio control.
Table 3-15

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Feed\Lag_Monomer.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

YC_Cocatalyst
The valve measurement point "YC_Cocatalyst" controls the flow volume (opening
of the feed input) to the vessel. The measurement point contains communications
modules for data exchange (control signals and control commands) with the
controller measurement point.
The valve module "V" contains an external manipulated variable (through
a communications module) from the controller measurement point. In a simulation
environment, both channel modules in chart partition "B" (Rbk and MV) receive
the same value (manipulated variable of the valve module (chart partition "A",
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sheet 1)) through the primary simulation module, i.e. a lag between valve actuation
and valve movement is not simulated.
The following table shows the configuration of the instance from "Val_An_Afb1".
Table 3-16

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Feed\Lag_Cocatalyst.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

from_CTRL In
Interconnection for the controller
(FIC_Cocatalyst\to_Valve.Out)

to_CTRL Out
Interconnection for the controller
(FIC_Cocatalyst\from_Valve.In)

Sim Sim1ActOp.Value 1
Activate simulation of the read-back
value

Sim Sim1ValueOp

Interconnected with the simulation of
the read-back value from the valve
(YC_Cocatalyst\V.MV)

Sim Sim2ActOp.Value 1
Activate simulation of the manipulated
variable

Sim Sim2ValueOp

Interconnection with the simulation of
the manipulated variable from the valve
(YC_Cocatalyst\V.MV)

YC_Diluent
The valve measurement point "YC_Diluent" controls the flow volume (opening of
the feed input) to the vessel. The measurement point contains communications
modules for data exchange (control signals and control commands) with the
controller measurement point.
The valve module "V" contains an external manipulated variable (through
a communications module) from the controller measurement point. In a simulation
environment, both channel modules in chart partition "B" (Rbk and MV) receive
the same value (manipulated variable of the valve module (chart partition "A",
sheet 1)) through the primary simulation module, i.e. a lag between valve actuation
and valve movement is not simulated.
The valve measurement point is additionally connected to the "NS-PumpDiluent"
pump. As soon as the valve opens, the interlock is released, thus allowing the
pump to be started.
The following table shows the configuration of the instance from "Val_An_Afb1".
Table 3-17

Module Connection Value Usage

V MV

Interconnection for the simulation and
pump
(Sim_Feed\Lag_Cocatalyst.In)
(NS_PumpDiluent\OperatingRange.In)

V
ER_AH_En
(not visible) 0

Switching off the alarm message with
maximum valve opening
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Module Connection Value Usage

V
ER_AL_En
(not visible) 0

Switching off the alarm message with
minimum valve opening

from_CTRL In
Interconnection for the controller
(FIC_Cocatalyst\to_Valve.Out)

to_CTRL Out
Interconnection for the controller
(FIC_Cocatalyst\from_Valve.In)

Sim Sim1ActOp.Value 1
Activate simulation of the read-back
value

Sim Sim1ValueOp

Interconnected with the simulation of
the read-back value from the valve
(YC_Cocatalyst\V.MV)

Sim Sim2ActOp.Value 1
Activate simulation of the manipulated
variable

Sim Sim2ValueOp

Interconnection with the simulation of
the manipulated variable from the valve
(YC_Cocatalyst\V.MV)

NS_PumpDiluent
Pump control is done in CFC "NS_PumpDiluent", based on the process tag type
"MOT_1sp_1fb_1cm__Std". The process tag type forms part of the master data
library.
The pump is controlled via SFC and is driven as soon as the downstream control
valve "YC_Diluent" opens (MV  1%). When the control valve is closed, the
interlock of the pump is active.



3 Design and principle of operation
3.4 Level control (Level)

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 28

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

3.4 Level control (Level)

Level control is done via the product discharge and is realized with the "Level-
Control" equipment module. The level calculation is performed in the simulation
chart. The reactor serves as a buffer, enabling a product discharge which is as
continuous as possible. For this purpose, a dead band is defined in the controller
CFC.

Design
The PID controller detects the fill level of the simulation chart and controls the
discharge flow volume depending on the predetermined fill level. If the fill level
comes below 30% of the reactor, the interlocking of the mixer is activated (mixer
"Agitation"). The following table provides you with an overview of the elements.

Table 3-18

Name Technical function /
process tag type

Description

LIC_Reactor "Level-Control" Level control
YC_Polymer "Level-Control" Control valve for the product discharge
NS_PumpReactor "MOT_1sp_1fb_1cm__Std" Pump to feed the reactor contents

Simulation "Sim_Level"
In the "Sim_Level" simulation chart, the fill level is calculated on the basis of the
difference between all inflows and the outflow.

Figure 3–7

1 2 3 4

5
6 7

8

1. Lag time of 4 seconds, which is caused by the inertia of the actuator,
and the time constant of the flow sensor.

2. The gain factor for the simulation of the process gain.
3. The scaling factor (negative inflow) for the polymer outflow volume.
4. Summation of all inflows including discharge.
5. Limiting the fill level by stopping the integration
6. Integration of the inflow sum
7. Fill level value with added noise signal
8. White noise signal as a simulation for measurement noise.
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Parameter assignment

LIC_Reactor
The process tag has the following different configuration when compared to the
"Level-Control" technical function.
Table 3-19

Module Connection Value Usage

C Gain 1.5 Controller gain
C TI 100.0 Controller lag
C DeadBand 5.0 Deadband width
C SP_InHiLim 100.0 Upper limit of the inner setpoint value

C PV_Out

Interconnection for
(Agitation\\NS_StirringMotor\OperatingRange.In)
(NS_PumpReactor\OperatingRange.In)

Sim Sim1ValueOp
Interconnection for the simulated process value
(Sim_Level\Noise_Level.Out)

PV Scale 100.0 Maximum value of the process value
PV PV_InUnit 1342 Process value unit in %

YC_Polymer
The process tag has the following different configuration when compared to the
"Level-Control" technical function.
Table 3-20

Module Connection Value Usage

V MV
Interconnection for the simulation
(Sim_Level\Lag_Polymer.In)

NS_PumpReactor
Pump control is done in CFC "NS_PumpReactor", based on the
"MOT_1sp_1fb_1cm__Std" process tag type. The process tag type forms part of
the master data library.
The pump is controlled via SFC and is driven as soon as the fill level increases
(fill level > 0%). When the reactor is empty, the interlock of the pump is active.



3 Design and principle of operation
3.5 Jacket temperature control (JacketTemp)

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 30

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

3.5 Jacket temperature control (JacketTemp)

The jacket temperature control realized with the "Split–Range–Temperature"
technical function provides the basis for an appropriate reaction environment.
The "MOT_1sp_1fb_1cm__Std" process tag type is additionally used for the
pumped circulation of the jacket fluid. The temperature calculation takes place in
the simulation chart.

Design
The PID controller detects the jacket temperature and increases or lowers it
according to the SFC temperature specification through the heating steam or
cooling water service media.
The following table provides you with an overview of all elements.

Table 3–21

Name Technical function /
process tag type

Description

TIC_Jacket "Split–Range–Temperature" Slave controller for the split-range control with
one controller output and two actuators

YC_Jacket_C "Split–Range–Temperature" Actuator for heating steam
YC_Jacket_H "Split–Range–Temperature" Control valve for the cooling water
NS_PumpJacket "MOT_1sp_1fb_1cm__Std" Pump (e.g. flow pump) for the continuous pumped

circulation of the jacket fluid

Note The display process tag and the controller process tag of the "TIC_Temp" master
controller of the "Split–Range–Temperature" equipment module are not needed
in this case and are therefore not part of the solution. For this reason, the
communication blocks "to_Master" and "from_Master" have been deleted in the
"TIC_Jacket" process tag. The missing process tags and interconnections have
no effect on the functionality and are not described separately.

Sim_JacketTemp simulation
The "Sim_JacketTemp" CFC chart (part of the "Split–Range–Temperature"
technical function) was reduced to the simulation part of the heat exchanger
("TempLevel" block) and contains an additional noise signal.
The figure below shows the structure and sequence of the simulation.
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Figure 3–8

1

2

1. Generating a noise signal (process behavior)
2. Adding the noise signal to the temperature value of the reactor jacket and

environment-related drop in temperature (0.001 degree Celsius)

NS_PumpJacket
Pump control is done in CFC "NS_PumpJacket", based on the
"MOT_1sp_1fb_1cm__Std" process tag type. The process tag type forms part of
the master data library.

Note You will find the information on the description, configuration and procedure of
the process tag type "MOT_1sp_1fb_1cm__Std" in chapter 4 "Individual Control
Level" of the documentation under the Entry ID: 53843373.

Note The interlocking of the pump can be carried out (configured) for the following
cases:
- if the controller is turned off
- a leak is detected in the jacket

Parameter assignment
The temperature control via the reactor jacket is configured for autonomous
operation. Since no effects of other system components are simulated in this
example and the controller has a fast response, no changes shall be carried out
for this example.
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3.6 Product temperature control (Cooling)

The temperature control is used for the heat dissipation of the reaction heat.
To counteract the resulting reaction heat, a portion of the contents of the reactor
is continuously pumped through an external heat exchanger and cooled down with
a service medium, such as cooling water. The temperature control is realized with
the "Temperature-Flow Cascade" technical function.

Design
The master controller of the motor staging gets the setpoint temperature of
the polymer melt defined as an external setpoint value from the "XC_Polymer"
multivariable controller. The master controller "TIC_Polymer" gives the flow volume
of the service medium to the "FIC_ServMedium" slave controller as an external
setpoint value.
The following table provides you with an overview of all elements.

Table 3-22

Name Technical Function Description

TIC_Polymer "Temperature-Flow-Cascade" Master controller to control the temperature
FIC_ServMedium "Temperature-Flow-Cascade" Slave controller for the flow control
YC_ServMedium "Temperature-Flow-Cascade" Control valve for the coolant

Simulation
The flow volume of the cooling water to the heat exchanger is simulated in the
simulation chart. In the "Sim_Reactor" process simulation, the change in
temperature (temperature increase due to the chemical process and the cooling
down through the Service medium) is simulated again.

Figure 3–9

1 2

1. Lag time of 4 seconds, which is caused by the inertia of the actuator as well
as by the time constant of the flow sensor.

2. The gain factor for the simulation of the process gain.

Parameter assignment

TIC_Polymer
The process tag has an additional "to_MPC" block which serves as a connection to
the "XC_Polymer" multivariable control measuring point. The manipulated variable
of the multivariable controller measurement point is used as an external setpoint
value for the control.
The "to_MPC" ("ComStruIn") block passes control commands from the PID
controller ("SP_InHiOut", "SP_InLoOut", "PV_Out", "CascaCut", "PV_UnitOut")
to the MPC controller.
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The process tag has the following different configuration when compared to the
"Temperature-Flow-Cascade" technical function.
Table 3-23

Module Connection Value Usage

C NegGain 1 Negative controller gain
C Gain 2.0 Controller gain
C TI 20.0 Controller lag
C SP_InHiLim 90.0 Maximum value of the internal setpoint

Connector SP_Ext
Manipulated variable of the multivariable controller
(XC_Polymer\ConnMPC.MV4Out)

ComStruIn
Entered as "to_MPC" for transmitting control signals
to the multivariable controller measurement point

to_MPC Out
Interconnection of the multivariable measuring point
(XC_Polymer\from_CTRL_4.In)

to_MPC ReStru1

Interconnection to the maximum value of the internal
setpoint
(TIC_Polymer\C.SP_InHiOut)

to_MPC ReStru2

Interconnection to the maximum value of the internal
setpoint
(TIC_Polymer\C.SP_InLoOut)

to_MPC ReStru3
Interconnection to the process value
(TIC_Polymer\C.PV_Out)

to_MPC BoStru1
Interconnection to the cascade signal
(TIC_Polymer\C.CascaCut)

to_MPC Int1
Interconnection to the process value unit
(TIC_Polymer\C.PV_UnitOut)

Sim Sim1ValueOp
Interconnection for the simulated process value
(Process\Simulation\Sim_Reactor\Temp_Polymer.Out)

PV Scale 120.0 Maximum value of the process value

FIC_ServMedium
The process tag has the following different configuration when compared to the
"Temperature-Flow-Cascade" technical function.
Table 3-24

Module Connection Value Usage

C Gain 2.769 Controller gain
C TI 1.639 Controller lag
C SP_InHiLim 400.0 Maximum value of the internal setpoint
PV Scale 400.0 Maximum value of the process value
PV PV_InUnit 1349 Unit of the process value (m3/h)
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3.7 Pressure control (Pressure)

The pressure control is realized with the "Split–Range–Pressure" technical
function. The pressure calculation takes place in the simulation chart.

Design
The PID controller senses the vessel pressure from the simulation chart and
increases the pressure with nitrogen or decreases it (ventilation) depending on the
defined value. The following table provides you with an overview of the elements.

Table 3-25

Name Technical function /
process tag type

Description

PIC_Pressure "Split–Range–Pressure"  Controller for the split-range control with one controller
output and two actuators

YC_Nitrogen "Split–Range–Pressure"  Control valve for the nitrogen supply
YC_Exhaust "Split–Range–Pressure"  Control valve for ventilation

Since the focus of the application is not the pressure control and no effects are
simulated from a fill level change or leakage, the simulation and the configuration
remain unchanged.

Note The Feature-Bit 25 is activated in the "V" block of the CFC "YC_Nitrogen" and
"YC_Exhaust".
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3.8 Mixing (Agitation)

Design
The mixer stirs the educts in the reactor. This is turned on or off by the plant
operator or via a step sequencer. If a fill level comes below 30% of the reactor,
the interlocking of the mixer is activated. The following table provides you with an
overview of the elements.

Table 3-26

Name Technical function /
process tag type

Description

NS_StirringMotor "MOT_1sp_1fb_1cm__Std" Stirring motor

NS_StirringMotor
Mixer control is done in the CFC "NS_StirringMotor", based on the
"MOT_1sp_1fb_1cm__Std" process tag type. This process tag type is used
for motors that have a constant rpm and forms part of the master data library.
The "OperatingRange" "Limit" block has been additionally added in page 2 of
chart partition "A" for interlocking when the fill level is falling short.
The following table shows the configuration of the instance from
"MOT_1sp_1fb_1cm__Std".
Table 3-27

Module Connection Value Usage

OperatingRange OutHiLim 30
Limiting value that indicates if the fill level
has been exceeded

OperatingRange OutHiAct
Interconnection for the interlocking
(Intlock.In01)



3 Design and principle of operation
3.9 Concentration and melt flow index (product)

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 36

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

3.9 Concentration and melt flow index (product)

The multivariable control regulates the concentrations of hydrogen, comonomer
and monomer (reaction conditions) as well as the melt flow index (MFI) as
a measure of product quality. To this end, the controller defines its manipulated
variables as external setpoint values for the downstream controls of the
comonomer flow, hydrogen flow, catalyst flow, and reactor temperature.
The density calculated in the process simulation is additionally displayed in
a separate measuring point.
The product quality is not directly measurable in a polymerization reactor, but is
determined by laboratory samples. Therefore, a soft sensor calculates the two
most important parameters of the product quality: the melt flow index and the
density of the polymer. This soft sensor is based on a physical model. Since the
sensor has to be developed for a specific application, it is not part of this sample
solution.
The following table provides you with an overview of the elements

Table 3-28

Name Process tag type Description

XC_Product "CTRL_MPC" Multivariable controller as a master controller
QI_MFI "AMON_Connect" Measuring point for displaying the melt flow index
QI_H2fraction "AMON_Connect" Measuring point for displaying the H2 concentration
QI_C4fraction "AMON_Connect" Measuring point for displaying the C4 concentration
QI_C2fraction "AMON_Connect" Measuring point for displaying the C2 concentration
QI_Density "AMON__Std" Measuring point for displaying the polymer density
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In the following figure the structure with the cross-chart interconnection is depicted
in simplified form.

Figure 3–10
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Simulation
Figure 3–11

In the "Sim_Reactor" simulation chart, a process variable is calculated in each
sheet. Operating points, delays and interactions are defined for each process
variable. The dynamic model describes deviations from the operating points for
each process variable.
For a description of the simulation, please refer to Chapter "Process simulation
(Simulation)".

Parameter assignment

XC_Polymer
For controlling with the multivariable controller measurement point "XC_Polymer",
the following variables are used and interconnected.
CVs (Controlled Variables):
 H2fraction
 C4fraction
 C2fraction
 MFI

MVs (Manipulated Variables, setpoint values for subordinate slave controllers):
 Flow volume of comonomer educt
 Flow volume of hydrogen educt
 Flow volume of catalyst
 Temperature inside the reactor
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The process tag contains communications modules for connecting slave controllers
and for displaying control variables, and is an instance from the process tag type
"CTRL_MPC".

Note The process tag type "CTRL_MPC" is designed for three measured and
controlled variables. Four measured and controlled variables are needed at the
reactor, which is why the blocks "MV4_TrkOn", "from_CTRL_4", "to_Indicate_4",
"PV4", "Sqrt4" were additionally designed.

Table 3-29

Module Connection Value Usage

MPC MV1Man 138.0 Manipulated variable in setup mode
MPC MV2Man 21.6 Manipulated variable in setup mode
MPC MV3Man 30.6 Manipulated variable in setup mode
MPC MV4Man 85.5 Manipulated variable in setup mode

MPC MV1HiLim
Switched and interconnected visibly with
(from_CTRL_1.ReStru1)

MPC MV1LoLim
Switched and interconnected visibly with
(from_CTRL_1.ReStru2)

MPC DB_No 18 DB number with controller data
MPC Restart 1 Restart and import of the data from the DB

MPC CV4_Unit
g /
10min

The user-specific unit has been entered in
the line "CV4_Unit" and column "Unit" of
the object properties of the MPC

SP10ptHiLim In2 0.5 SP1 upper limit for MPC optimization
SP10ptLoLim In2 -0.5 SP1 lower limit for MPC optimization
SP20ptHiLim In2 0.1 SP2 upper limit for MPC optimization
SP30ptLoLim In2 -0.1 SP2 lower limit for MPC optimization
SP30ptHiLim In2 1.0 SP3 upper limit for MPC optimization
SP30ptLoLim In2 -1.0 SP3 lower limit for MPC optimization
SP40ptHiLim In2 0.1 SP4 upper limit for MPC optimization
SP40ptLoLim In2 -0.1 SP4 lower limit for MPC optimization

ConnMPC MV1Out
Manipulated variable for the comonomer flow
(Feed\\FIC_Comonomer\Connector.SP_Ext)

ConnMPC MV2Out
Manipulated variable for the hydrogen flow
(Feed\\FIC_Hydrogen\Connector.SP_Ext)

ConnMPC MV3Out
Manipulated variable for the catalyst flow
(Feed\\FIC_Catalyst\Connector.SP_Ext)

ConnMPC MV4Out

Manipulated variable for the product
temperature
(AirSupply\\FIC_HotAir\Connector.SP_Ext)

from_CTRL_1 In

Interconnection of the comonomer
measuring point
(Feed\\FIC_Comonomer\to_MPC.Out)

from_CTRL_2 In

Interconnection of the hydrogen measuring
point
(Feed\\FIC_Hydrogen\to_MPC.Out)

from_CTRL_3 In
Interconnection of the catalyst measuring
point  (Feed\\FIC_Catalyst\to_MPC.Out)
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Module Connection Value Usage

from_CTRL_4 In

Interconnection of the product temperature
measuring point
(Cooling\\TIC_Polymer\to_MPC.Out)

to_Indicate_1 Out
Interconnection for the H2 fraction display
(Product\\QI_H2fraction\from_CTRL.In)

to_Indicate_2 Out
Interconnection for the C4 fraction display
(Product\\QI_C4fraction\from_CTRL.In)

to_Indicate_3 Out
Interconnection for the C2 fraction display
(Product\\QI_C2fraction\from_CTRL.In)

to_Indicate_4 Out
Interconnection for the flow index display
(Product\\QI_MFI\from_CTRL.In)

Sim Sim1ActOp.Value 1 Activation of the simulation

Sim Sim1ValueOp

Interconnection for the simulated product
temperature
(Process\Simulation\Sim_Reactor\V_Hydrog
en.Out)

Sim Sim2ActOp.Value 1 Activation of the simulation

Sim Sim2ValueOp

Interconnection for the simulated product
moisture content
(Process\Simulation\Sim_Reactor\P_part_Co
Mo.Out)

Sim Sim3ActOp.Value 1 Activation of the simulation

Sim Sim3ValueOp

Interconnection for the simulated product
moisture content
(Process\Simulation\Sim_Reactor\V_Monom
er.Out)

Sim Sim4ActOp.Value 1 Activation of the simulation

Sim Sim4ValueOp

Interconnection for the simulated product
moisture content
(Process\Simulation\Sim_Reactor\MFI.Out)

PV1 Scale 50.0 Maximum value of the process value
PV1 PV_InUnit 1562 Process value unit (%vol)
PV2 Scale 4.0 Maximum value of the process value

PV2 PV_InUnit 1562 Process value unit (%vol)

PV3 PV_InUnit 1562 Process value unit (%vol)

PV4 Scale 2.5 Maximum value of the process value
PV4 PV_InUnit 0 Process value unit

Note If a setpoint range (control range of a slave controller) is less than 0 or greater
than 100, the corresponding speed range at the MPC input parameters
"MVxHiLim" and "MVxLoLim" needs to be adjusted or additionally connected
to the communication block "from_CTRL_x" and the parameters of the upper
speed range "ReStru1" and lower speed range "ReStru2".
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Note Commissioning of the multivariable controller was carried out based on the
"fluidized bed dryer" application description of a model predictive controller,
with working point optimization. You will find the example under the Entry ID:
61926069. Before optimizing the controller, it is important to carry out an
excitation for each manipulated variable (MPC in "Manual" operating mode)
and to wait until the excitation completes for all process data.

QI_H2fraction
The display measuring point is used for the display and monitoring of the hydrogen
(H2) concentration for the multivariable control measuring point. The operator can
set alarm and warning limit values.
The following table shows the configuration of the instance from "AMON_Connect".
Table 3-30

Module Connection Value Usage

from_CTRL In

Interconnection to the controlled variable of
the multivariable controller
(XC_Polymer\to_Indicate_1.Out)

QI_C4fraction
The display measuring point is used for the display and monitoring of the
comonomer (C4) concentration of the multivariable control measuring point.
The operator can set alarm and warning limit values.
The following table shows the configuration of the instance from "AMON_Connect".
Table 3-31

Module Connection Value Usage

from_CTRL In

Interconnection to the control variable of
the multivariable controller
(XC_Product\to_Indicate_2.Out)

QI_C2fraction
The display measuring point is used for the display and monitoring of the monomer
(C2) concentration of the multivariable control measuring point. The operator can
set alarm and warning limit values.
The following table shows the configuration of the instance from "AMON_Connect".
Table 3-32

Module Connection Value Usage

from_CTRL In

Interconnection to the controlled variable of
the multivariable controller
(XC_Product\to_Indicate_3.Out)

https://support.industry.siemens.com/cs/ww/en/view/61926069
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QI_MFI
The display measuring point is used for the display and monitoring of the melt flow
index (MFI) of the multivariable control measuring point. The operator can set
alarm and warning limit values.
The following table shows the configuration of the instance from "AMON_Connect".
Table 3-33

Module Connection Value Usage

from_CTRL In

Interconnection to the controlled variable of
the multivariable controller
(XC_Product\to_Indicate_4.Out)

I PV_Unit
g /
10min

The user-specific unit has been entered in the
line "PV_Unit" and column "Unit" of the object
properties

QI_Density
The display measuring point is used to display and monitor the polymer density.
The density is calculated in the process simulation and only connected for display
purposes. The operator can set alarm and warning limit values.
The following table shows the configuration of the instance from "AMON__Std".
Table 3-34

Module Connection Value Usage

Sim Sim1ActOp 1 Activate the simulation values

Sim Sim1ValueOp
Interconnection for the simulated process value
(Process\Simulation\\Sim_Reactor\Density.Out)

PV Scale 1000.0 Maximum value of the process value
PV PV_InUnit 1097 Unit of the process value (kg/m3)
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3.10 Process simulation (Simulation)

The CFC chart "Sim_Reactor" contains all of those parts of the simulation model
that not only describe an individual system section but also have an overarching
nature. The role of process simulation is to understand the functioning of the
polymerization reactor, particularly in relation to the control functions of the
multivariable controller or to be able to demonstrate it. It does not claim to
replicate exactly the real physical behavior of a particular reactor.
A matrix with linear, dynamic transfer functions is used as a model for process
simulation. The process model is a 6x4 multi-variable system, whereby the
influence of each input variable on every output variable is simulated by a separate
partial transfer function. The model describes the temporal behavior of process
deviations from the working point. The process simulation runs in time lapse,
i.e. 100 times faster than real-time.

Note The CFC chart "Presettings" allows you to set the time lapse as well as reset
the delays and activate or deactivate the process noise.

Furthermore, the operating points lag times and downtimes can be parameterized
for each process variable. The partial transfer functions are realized with different
dynamic models (PT1, PT2 or PT3 behavior). Each partial transfer function receives
the respective differential value from the predefined working point and the current
value of the input variables and outputs them correspondent to its transfer
functions at the output point. At the end, for each process output variable yi
the associated working point is added.

Note All PTn transfer functions are structured as 'chart in chart' according to the same
principle, whereby only the required functional parts are activated. A transfer
function contains three sequentially switched delay elements and a booster
element. Furthermore, noise can be added to the output signal
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In the following figure, the process model is depicted with the corresponding
names.

Figure 3–12: Partial transfer functions of the process model
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The process variables "MFI" (melt flow index), "V_Monomer" (concentration of the
monomer), "P_part_CoMo" (concentration of the comonomer) and "V_Hydrogen"
(concentration of hydrogen) are required for multivariable control. The process
variable "Temp_Polymer" is used to control the polymer temperature in the reactor,
and "Density" to show the polymer density.

Note The numbering of the process variables does not match the numbering of the
controlled variables of the MPC, but corresponds to the arrangement in the CFC
chart.

The following figure shows the simulation block (chart-in-chart) of Sheet 1 for the
calculation of the MFI (melt flow index). Different process values are calculated in
the same way with different parameters in each sheet.
Figure 3-13

31

2
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1. Calculation of the MFI
The MFI is calculated in this block. The associated operating point as well as
the delays (TPx_x), the dead time (DeadTime) and the gain (gain_x) are all
specified under each connected parameter. In the block, the deviations on
the operating point are calculated, added together and sent to the output in
individual transfer functions for each interconnected manipulated variable
(comonomer, hydrogen, catalyst and cooling water to the heat exchanger).

2. Process noise
In this block, an artificial error is created in the form of a fluctuation in the block.
This error, as well as all other errors of the process simulation, is activated
centrally in the CFC "Presettings".

3. Output value
In this block, the process value, if enabled, is given with accumulated process
noise.
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3.11 Sequencers

At the start of production, the plant is run dry, the reactor is purged with nitrogen
and then taken into production operation whereby the individual plant components
approach their operating points.

Note The composition and viscosity of the product produced at the beginning of the
startup process does not meet the specified criteria, so that after a few minutes
the desired or pre-selected product quality is delivered.

Sequencers support the plant operator during start-up and shut-down of a plant or
during errors.
During start-up the process is placed in the defined operating point. The controllers
are optimized for the specific operating point and are switched to automatic mode
when reaching the operating point. This example takes the control of multivariable
controllers after approaching the specified product quality (concentration, and melt
flow index).
Different behavior and modes of operation can be realized in SFC. In the sample
project the SFC "StartReactor" is configured for automatic start-up without user
interaction. After start-up, the controller is transferred to the user in automatic
mode, allowing him to determine, for instance, the individual setpoint values.
The following sequencers are components of the SFC and are described below:
 PREPARING
 STARTUP
 RUNNING

The SFC are designed for the simulation and can only be understood as
a reference points for real plants, i.e. if necessary, they have to be modified for
use in real systems.

Note To determine the setpoint value and operating mode selection, the necessary
parameterization is used, incl. the schematic representations from the function
manual "SIMATIC Process Control System PCS 7 Advanced Process Library
(V8.0 SP1)". In the function manual under the Entry ID: 68154793 you can find
information on operating modes and setpoint value selection, as well as more
detailed information on all parameters of the APL blocks.

PREPARING
When starting the polymerization reactor, the sequencer (sequence)
"PREPARING" is performed at the beginning, which runs the unit in a non-
production operation. For this, all inflows are stopped, the reactor is emptied
and flushed with nitrogen.
The operational modes of all controllers except the pressure and level control
switch to automatic and are updated to the manipulated variable "0".
The pressure control and level control receive external setpoint values.

https://support.industry.siemens.com/cs/ww/en/view/68154793
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STARTUP
The sequencer "STARTUP" follows the sequencer "PREPARING". During the
starting phase, the unit from the plant standstill (no production) is prepared for
operation in its normal state. To accomplish this, all controllers receive external
setpoint values and the tracking is stopped.
The following steps are performed in the sequencer:
1. Temperature control of the jacket temperature at 20°C
2. Reactor fill level (setpoint value) of 60%
3. Setting the MPC setpoint values (concentrations and melt flow index) and

manipulated variables for the tracking.
4. Setpoint value specification for all inflows and product temperature. All MPC

slave controllers receive internal setpoint values, while the remaining
controllers receive external setpoint values. The diluent pump is additionally
activated.

5. The remaining pumps and the mixer are activated after reaching a fill level
of 30%. The vessel also receives a setpoint value specification for the vessel
pressure.

6. After reaching the specified process variables (concentrations and melt flow
index), the MPC goes into automatic mode and all slave controllers use the
external setpoint value (manipulated variable of the MPC) for control.

Note The MPC is taken in automatic mode, as long as the subordinate controllers still
run with an internal setpoint value. As a result, all MPC outputs are tracked to the
correct values from the sequence control circuits. The subordinate controllers are
then switched to external setpoint values and the MPC switches smoothly
channel-by-channel from tracking into automatic mode.

RUNNING
In the sequencer "RUNNING", operator input is enabled for all controllers and
aggregates. To this end, the following parameters are changed:
 for PID controllers: "ModLiOp" = 0 and "SP_LiOp" = 0
 for MPC controllers: "ModLiOp" = 0
 for aggregates (pumps und mixers): "ModLiOp" = 0

Upon successful execution of the sequencer, the operator can define new setpoint
values for the controller.

Note The setpoint values of the slave controller from the motor staging cannot be
changed due to the pre-defined program logic. At the ratio blocks, you can
individually customize the inflows and therefore the setpoint values of the slave
controller of the ratio control.
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3.12 Process parameters (KPI)

The CFC chart "KPI" comprises key performance indicators that inform the
operator about the process performance. The following key performance indicators
are calculated and shown in the visualization:
1. Sheet dwell time (ResidenceTime): The dwell time is calculated from the

quotient of the reaction volume and exiting volume flow. During this process,
the reaction volume is calculated from the normalized fill level. The outflowing
volume flow outoductV ,Pr  corresponds to the product outflow of the fill level
control loop.

=
×

100% × ,

2. Space-time-yield sheet (SpaceTimeYield): The space-time-yield describes the
ratio between the incoming mass flows of educts inEm , and the total volume

of the reactor RV . Since the inflows are partially present as mass flows and
partially as volume flows in the simulation, the following relationship results
for this application.
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3. Catalyst productivity sheet (CatProductivity): The catalyst productivity KA
is derived from the ratio between the outflowing mass flow of the product

outoductm ,Pr  and the inflowing mass flow of the catalyst inCatalystm , .
The density of the product is thereby calculated by the simulation model:

2Pr yoduct  (See also Process simulation (Simulation)).
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Note The value for the catalyst productivity is coupled to the product discharge and
changes according to the controller output of the discharge valve. Due to the
predefined control gain factor, changes to the manipulated variables produce
major value fluctuations. In practice, it is not the short-term fluctuations, but
rather the long-term changes of the temporal mean value of the catalyst
productivity that are preferred.



3 Design and principle of operation
3.13 Task-related overview images with APG

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 49

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

3.13 Task-related overview images with APG

With PCS 7 Advanced Process Graphics, process pictures are displayed more
clearly, reduced to the essential and are intuitive to use. The focus lies in the
consideration of the relevant process variables within the working ranges.

3.13.1 Integration of APG

The integration of APG is configured in two phases:
1. Insertion and configuration of APG blocks in the measuring points (AS)
2. Placement and interconnection of APG objects (OS)

Note You can find basic information about APG, for extension of an existing PCS 7
project with APG and for configuration purposes in the application description
"Integration of Advanced Process Graphics in SIMATIC PCS 7" under the Entry
ID: 89332241.

3.13.2 APG measuring points (AS)

Two different range representations (ViewMode) are set in the project. The bar
graphs in the Level 2 process picture show the process value in the differential
representation, while in the Level 1 process picture, the bar graphs show the value
in the absolute representation.

Controller measuring points
All controller measuring points of the polymerization reactor contain an instance
of the APG connector block in "Sheet 1" of the chart partition "A" and are all
interconnected and parameterized as follows:
Table 3-35

Connection Value Usage

BockType 2 Representation suitable for the "PIDConL" block
ViewMode 1 Absolute representation (value range)
ViewRange 4 Display of the working range
ReadPointer Connected with "C.Status2"

The following values are configured for the boundaries of the HMI instances:
Table 3-36

Measuring point Connection Value Usage

FIC_Catalyst PV_OH_Li 40.0 Upper limit of the working range
FIC_Catalyst PV_OL_Li 15.0 Lower limit of the working range
FIC_Cocatalyst PV_OH_Li 2.5 Upper limit of the working range
FIC_Cocatalyst PV_OL_Li 0.0 Lower limit of the working range
FIC_Hydrogen PV_OH_Li 35.0 Upper limit of the working range
FIC_Hydrogen PV_OL_Li 15.0 Lower limit of the working range
FIC_Comonomer PV_OH_Li 200.0 Upper limit of the working range

https://support.industry.siemens.com/cs/ww/en/view/89332241
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Measuring point Connection Value Usage

FIC_Comonomer PV_OL_Li 100.0 Lower limit of the working range
FIC_Monomer PV_OH_Li 6300.0 Upper limit of the working range
FIC_Monomer PV_OL_Li 5700.0 Lower limit of the working range
FFIC_Diluent PV_OH_Li 48.0 Upper limit of the working range
FFIC_Diluent PV_OL_Li 15.0 Lower limit of the working range
LIC_Reactor PV_OH_Li 80.0 Upper limit of the working range
LIC_Reactor PV_OL_Li 45.0 Lower limit of the working range
PIC_Reactor PV_OH_Li 9.0 Upper limit of the working range
PIC_Reactor PV_OL_Li 6.0 Lower limit of the working range
TIC_Polymer PV_OH_Li 90.0 Upper limit of the working range
TIC_Polymer PV_OL_Li 80.0 Lower limit of the working range
FIC_ServMedium PV_OH_Li 110.0 Upper limit of the working range
FIC_ServMedium PV_OL_Li 70.0 Lower limit of the working range
TIC_Jacket PV_OH_Li 22.0 Upper limit of the working range
TIC_Jacket PV_OL_Li 18.0 Lower limit of the working range

Display measuring point
All display measuring points "QI_xxxxxx" contain two instances of the APG
connector block in "Sheet 1" of chart partition "A", the instance "HMI" for the
absolute representation of the process value and the instance "HMI_2" for the
differential representation. The measuring points are interconnected and
parametrized as follows:
Table 3-37

Module Connection Value Usage

HMI
HMI_2 BockType 1

Representation suitable for the "PIDConL"
block

HMI ViewMode 1 Absolute representation (value range)
HMI_2 ViewMode 2 Differential representation (value range)
HMI
HMI_2 ViewRange 4 Display of the working range
HMI
HMI_2 ReadPointer Connected with "C.Status2"

The following values are configured in the same way for each measuring point
of the boundaries of the "HMI" and "HMI_2" instances:

Table 3-38

Measuring point Connection Value Usage

QI_MFI PV_OH_Li 2.5 Upper limit of the working range
QI_MFI PV_OL_Li 1.0 Lower limit of the working range
QI_C2fraction PV_OH_Li 68.5 Upper limit of the working range
QI_C2fraction PV_OL_Li 60.0 Lower limit of the working range
QI_C4fraction PV_OH_Li 1.8 Upper limit of the working range



3 Design and principle of operation
3.13 Task-related overview images with APG

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 51

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

Measuring point Connection Value Usage

QI_C4fraction PV_OL_Li 1.0 Lower limit of the working range
QI_H2fraction PV_OH_Li 29.0 Upper limit of the working range
QI_H2fraction PV_OL_Li 24.0 Lower limit of the working range
QI_Density PV_OH_Li 950.0 Upper limit of the working range
QI_Density PV_OL_Li 940.0 Lower limit of the working range

KPI measuring point
The measuring point "KPI" contains three instances of the APG connector block
to display the process parameters. The measuring point is interconnected and
parametrized as follows:
Table 3-39

Module Connection Value Usage

HMI_1 BockType 1 Representation suitable for the "MonAnL" block
HMI_1 ViewMode 1 Absolute representation (value range)
HMI_1 ViewRange 4 Display of the working range
HMI_1 ReadPointer Connected with "ResidenceTime.Status2"
HMI_1 DispRatio 0.6 Ratio of display to ViewRange
HMI_1 PV_OH_Li 0.6 Upper limit of the working range
HMI_1 PV_OL_Li 0.01 Lower limit of the working range
HMI_2 BockType 1 Representation suitable for the "MonAnL" block
HMI_2 ViewMode 1 Absolute representation (value range)
HMI_2 ViewRange 4 Display of the working range
HMI_2 ReadPointer Connected with "SpaceTimeYield.Status2"
HMI_2 DispRatio 0.6 Ratio of display to ViewRange
HMI_2 PV_OH_Li 180.0 Upper limit of the working range
HMI_2 PV_OL_Li 100.0 Lower limit of the working range
HMI_3 BockType 1 Representation suitable for the "MonAnL" block
HMI_3 ViewMode 1 Absolute representation (value range)
HMI_3 ViewRange 4 Display of the working range
HMI_3 ReadPointer Connected with "CatProductivity.Status2"
HMI_3 DispRatio 0.6 Ratio of display to ViewRange
HMI_3 PV_OH_Li 400.0 Upper limit of the working range
HMI_3 PV_OL_Li 300.0 Lower limit of the working range
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3.13.3 APG objects (OS)

In order to provide the operator with an optimum working environment,
the following two process pictures were created:
 Level 1 process picture for orientation and navigation (system overview)
 Level 2 process picture for operator control and monitoring of a device, in this

case, the polymerization reactor

Note You can find detailed information and the procedure for configuring APG in the
Siemens Industry Online Support in the article "Integration of Advanced Process
Graphics in SIMATIC PCS 7" under the entry ID 89332241.

Level 1 process picture (orientation and navigation)
A process picture with a compressed representation of the main driving parameters
is available for the monitoring of the process-related parameters of the overall
system. This allows the overall context to be quickly detected and impressed as
a pattern.

https://support.industry.siemens.com/cs/ww/en/view/89332241
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Level 2 process picture (operator control and monitoring)
Another process picture is available for the monitoring of the process-related
parameters of the reactor and also for operator control, which schematically
represents the most important process values and control of the reactor. This
representation has the advantage that large volumes of data can be combined
to form a compressed and clear display of information.
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4 Starting of the Unit template
4.1 Preparations

The following instructions describe putting the Unit template into service by
simulating the controller with the "S7-PLCSIM" program. If there is a real controller,
you must configure existing hardware components in the HW Config.

Table 4-1

No. Action

1.  Copy the file "84061788_PolyReactor_PCS7V801.zip" into any folder on the configuration PC
and then open the SIMATIC Manager.

2.  In the menu bar, click on "File > Retrieve" and select the file
"84061788_PolyReactor_PCS7V801.zip". Then confirm with "Open".

3.  Select the folder in which the project should be saved and confirm by pressing "OK".
The project will be retrieved.

4.  Confirm the "Retrieve" dialog with the "OK" button and then click on "Yes" in the dialog to
open the project.

5.  Right-click on "UT_PolyReactor_OS > SVES4ALL02 > WinCC Appl. > OS" and click on
the menu command " open object".

6.  Confirm the "Configured server not available" dialog with "OK".
7.  In the WinCC Explorer, open the characteristics of your computer and, in the opened

Characteristics dialog, click on the "Adopt local computer name" button.
Click the "OK" button to confirm the message "Change PC name".

8.  In the WinCC Explorer, click on "File > End" and, in the subsequent dialog, select "Terminate
WinCC Explorer and close project".
Then confirm with OK.

9.  Reopen the WinCC Explorer as described in step 5.
10.  Open by double-clicking on "Variables library". In the "WinCC Configuration Studio", right-click

on "Variables library > SIMATIC S7 Protocol Suite > Industrial Ethernet" and select the menu
command "System parameters".

11.  In the "Unit" register, check the "Logical device names" setting. If the "S7-PLCSIM" is used,
the device name PLCSIM(ISO) is selected. If the device name is changed, the program must
be restarted. Reopen the WinCC Explorer as described in step 5.
Note
If the OS cannot establish a connection with the AS (grayed out image modules), select the
logical device name "CP_H1_1:" and restart the OS.



4 Starting of the Unit template
4.2 Commissioning

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 55

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

4.2 Commissioning

The following instructions describe how the Unit template is initialized.
To put into service, it is required that SIMATIC Manager is already open and that
the project has been selected in the component view.

Starting the simulation (S7-PLCSIM)
To start the simulation, proceed according to the following instructions:

Table 4-2

No. Action

1. Select "Extras > Simulate Modules" from the menu.
The "S7-PLCSIM" dialog window opens.

2. In the "Open project" dialog, select "Open project from file".
3. Select the file "PolyReactor.plc" from the path

<Project path>\UT_PolyR\PolyReactor\PolyReactor.plc>.
4. In the menu, select "Execute > Key-switch position > RUN-P".
5. Switch to the component view of the SIMATIC Manager and mark "UT_PolyRactor_AS >

AS01".
6. In the menu bar, click on "Target system > Load" and confirm the "Load" dialog with "Yes".

Confirm the "Stop target group" dialog with "OK" and the subsequent "Load" dialog with "Yes".

Activate OS (WinCC Runtime)
To activate the OS, proceed according to the following instructions:

Table 4-3

No. Action

1. Right-click on "UT_PolyReactor_OS > SVES4ALL02 > WinCC Appl. > OS" and click on
the menu command " open object".

2. To activate the OS (WinCC Runtime), select "File > Activate"
 in the WinCC Explorer menu.

3. In the "System Login" dialog, enter as "Login" the user "Unit" and "Template" as the
password; confirm with "OK".

4. Select the Unit template "PolyReactor" in the image area.

Note
The polymerization reactor is already located in the production process because the AS
program execution (PLCSIM) has been started.
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5 Operation of the application
5.1 Overview

Some of the polymerization reactor's components can be operated and monitored
by means of the process picture. In addition, the plant operator receives
information (KPI's) for the current process.

Note Please note that after CPU start it takes about 15 minutes until the plant goes in
production operation, which meets the specified quality requirements. During
the running production operation, all controllers are enabled. You can identify
this state in the SFC when it has successfully processed all sequences, among
others.

The following scenarios relate to the handling of the "Polymerization Reactor" unit
template:
 Procedure for controller optimization
 MPC working point optimization
 Monitoring the progress of the process with APG

5.2 Scenario A –Procedure for controller optimization

Thanks to its wide range of control loops, this application offers a great way to
perform optimizations for individual control loops, starting with simpler controls,
such as fill level control, to complex multivariable controls for polymerization.
The basic procedure for controller optimization is described in the following.
After a successful startup of the plant, all controllers are enabled, so that separate
setpoint values can be specified after switching to the internal setpoint value.

Standard PID controller
The PID controls, with the exception of the slave controller of the MPC and the
motor staging, operate independent from the process simulation of the MPC.
The Following optimization is explained using the example of the flow
"FIC_Cocatalyst" and described only until the optimization dialog. A detailed
description for the controller optimization can be found in the application notes:
 "Equipment Modules for PCS 7 using the example of the Chemical Industry"

under the entry ID: 53843373, in chapter "Configuration of the PID controller"
 "PID Control with Gain Scheduling and PID Tuning" under the entry ID:

38755162

Table 5-1

No. Action

1. In the OS, switch to the process picture and select the block icon "FIC_Cocatalyst".
This will open the corresponding faceplate.

https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/38755162


5 Operation of the application
5.2 Scenario A –Procedure for controller optimization

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 57

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

No. Action

2. Change the setpoint value specification to the internal setpoint value.

Note
The setpoint value is tracked so that the switchover does not bring about any changes.

3. Change the faceplate in the "Parameters" range and activate the setting "PID optimization".

4. Switch to the SIMATIC Manager and open the chart partition "A", sheet "1" of the CFC chart
"FIC_Cocatalyst".

5. Select the controller block "C" and choose the menu command "Edit> Optimize PID
controller ...".

6. Carry out the controller optimization.
Note
Please note that the flow does not consist an integral part and the excitation to the
optimization does not deviate much from the operating point.

Note If the operating point changes, the SFC must be adapted according to the new
operating point.
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MPC controller
The multivariable control is applicable for slower but more sophisticated processes.
Before optimizing the multivariable controller, the slave controllers must first display
a stable control behavior. This relates to the example of the educt flow and the
temperature control via the heat exchanger.
The steps are described until the optimization dialog for the following optimization.
A detailed description for the MPC optimization, can be found in the application
notes
  "Fluidized Bed Dryer - Design of Model Predictive Control with Economical

Steady State Optimization" under the entry ID: 61926069
 "PCS 7 Unit Template "Distillation Column" using the example of the Chemical

Industry" under the entry ID: 48418663, in chapter "Configuration of the MPC
controller"

Note Please note that in the listed applications, MPC controls are described with
different numbers of controlled variables and disturbance variables. The basic
procedure for controller optimization is however identical and can also be applied
to this example.

Table 5-2

No. Action

1.  In the OS, switch to the process picture and select the block icon "XC_Polymer".
This will open the corresponding faceplate.

2.  In the operating mode, change to manual.

Note
All manipulated variables are tracked so that the switcheover does not bring about any
changes.

https://support.industry.siemens.com/cs/ww/en/view/61926069
https://support.industry.siemens.com/cs/ww/en/view/48418663
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No. Action

3.  Open in order to monitor the trend display (1) of the process variable. Perform an excitation
for the first setpoint value (2) and wait until the excitation process is complete.

Note.
Depending on the controlled variable, it can take about 15 minutes until most of the excitation
process is complete. From the trend diagram, you can determine the time and the influence
of the excitation. This data allows you to determine the parameters for the excitation block
"AutoExcitation".

4.  After the evaluation, remove, for example, the excitation in the trend display and wait again
until this excitation process is complete.

5.  Carry out steps 3 and 4 for all controlled variables.
6.  Switch to the SIMATIC Manager and open the chart partition "A", sheet "1" of the CFC chart

"XC_Polymer".
7.  Open the Trend display via the menu command "View> Trend display...".
8.  Add all four process values (CVx) and manipulated variables (MVx) of the trend display and

parameterize the value ranges according to the configuration at the MPC.
You can alternatively use the pre-made trend indicator in the MPC block.
Note
You can take the value ranges for the process values from the channel drivers in chart
partition "B" of the CFC and the slave controller of the MPC for the manipulated values.
Alternatively, you can use the input parameters "SPxHiLim" and "SPxLoLim" for the process
value limits, "MVxHiLim" and "MVxLoLim" for the manipulated variable limits at the MPC and
switch them to visible.

9.  Parameterize the "AutoExcitation" block according to your records of the excitation process
for all four manipulated variables (NumberMV = 4).
Note
Set the manipulated variables and the duration of the excitation process in a way that
a change in the process value can be identified.

10.  Start the trend logging and wait 30 seconds until the first values (no skips) are recorded.
11.  Start the excitation process in the visibly switched "AutoExcitation" block and wait until all

excitation processes are fully completed.
Note
The excitation can take several hours, depending on the preset time.

12.  After completing the excitation, export the trend log.
Note
In the project path "<<Projekt path>\UT_PolyR\PolyReactor" you can find the exported trend
log "MPC_Record_20140227.csv" for optimization.
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No. Action

13.  Select the block "MPC" and click in the menu bar "Edit
> Configure MPC".

14.  In the MPC configurator, run the control design with the exported trend log.

5.3 Scenario B – MPC working point optimization

The MPC controller allows economic optimization of the stationary operating point
under consideration of setpoint tolerance limits. To this end, deviations allowed by
the controller (degrees of freedom) are defined, in which the setpoint values may
move. This range is also referred to as the tolerance range. When the operating
point optimization is activated, the controller finds the manipulated variables within
the tolerance ranges, in sense of the most advantageous performance criterion.
If there is no extra information (computation of the economic data) available for
the control, the lowest tolerance values are approached.
Define the performance criterion in the parameter view. To this end, you can define
specific costs for each manipulated and controlled variable of the MPC that should
be minimized, or revenues which should be maximized.
The example considers the following dependencies:
 The MVs 1…3 are educt streams and cause higher costs if they rise.
 The MV 4 corresponds to the reactor temperature and reduces costs when it

rises. At a higher temperature, the demand for cooling energy is reduced.
 The CVs involve no costs, however they must be kept within specified

tolerance ranges to produce a salable product.
 The sale revenue depends on the product outflow. In a first approximation,

the discharge is equal to the sum of the educt inflows. Since the main raw
material, i.e. the monomer, is supplied at a constant rate, the product
discharge may also be assumed to be approximately constant.

The objective of the optimization is therefore to achieve the required specifications
with the least possible use of raw materials and cooling energy.
The minimization of costs is taken as a basis for the performance criterion.
To this end, the following gradient for MV 1…4 is set:
 GradMV1 = 11
 GradMV2 = 12
 GradMV3 = 22
 GradMV4 = -8

Table 5-3

No. Action

1.  In the OS, Switch to the process image of the polymerization reactor and wait until all
operating points are reached and the controllers are enabled.



5 Operation of the application
5.3 Scenario B – MPC working point optimization

Polymerization Reactor
Entry ID: 84061788,    V1.2,    09/2015 61

S
ie

m
en

s
A

G
20

15
A

ll
R

ig
ht

s
R

es
er

ve
d

No. Action

2.  Click on the module symbol of the "XC_Polymer" multivariable controller and verify the limit
value settings for the optimization (parameter assignment) of all control variables.

3.  For the optimization, set the gradients (weighting factors) for MV1 to MV4 with the
optimization goal of cost minimization.
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No. Action

4.  To monitor the MPC control, open the "Trend_MPC" trend display by means of the "Call up /
consolidate curve groups" button.

Note
The trend display can also be extended to other values, such as the current economic
revenue from the performance criterion.

5.  To optimize, press the "Optimization" button and monitor the changes to the trend indicator.

6.  After about 14 minutes, the operating point optimization is mostly completed.
7.  Stop the trend tracking in order to carry out an evaluation of the recorded data.

For this purpose, you can also adjust the scaling of the time axis.
Note
The individual controller values (SPs, CVs and MVs) are archived, so that you can select your
own time ranges in the trend indicator.
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Evaluation
Figure 5–1 – Trend logging for the operating point optimization
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SP1 CV1

MV1

SP3 CV3
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SP4CV4
MV4

After switching on the optimization, the MPC adopts the lower optimization limits
for SP1 and SP2 and the upper optimization limits for SP 3 and SP4 as new
setpoint values according to the weighting in the performance criterion.
All manipulated variables (MV) are passed on to the downstream controls as
setpoint value specifications.
In terms of product quality, this means a higher MFI at lower concentrations.
A higher product temperature (MV4) is required for the higher MFI. For a higher
product temperature, the downstream control itself requires less cooling water to
be passed through the heat exchanger, which in turn may result in lower costs.
In this sample calculation, the operating point optimization can reduce costs by
more than 10% from 1640 €/h to 1464 €/h with the adopted performance criteria.

Note To perform an effective and meaningful optimization, it is necessary to provide
the MPC with additional process-related technical data and limits, as well as
basic economic information (revenues and costs). Costs or revenues, which
do not have to depend on a constant factor of the manipulated or controlled
variables of the MPC, must be calculated if required. This calculation of the
economic data is to be carried out in a separate CFC and interconnected with
the MPC.

You can find a good example of an economic operating point optimization in
the example "Fluidized Bed Dryer - Design of Model Predictive Control with
Economical Steady State Optimization" under the entry ID: 61926069 and the
application example with integrated process simulation "PCS 7 Unit Template
"Dryer" using the example of the Chemical Industry" under the entry ID:
74747848.

https://support.industry.siemens.com/cs/ww/en/view/61926069
https://support.industry.siemens.com/cs/ww/en/view/74747848
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5.4 Scenario C – Monitoring the progress of the process
with APG

APG provides the plant operator with a rapid overview of all task-related process
variables. Two process pictures of the polymerization reactor have been
engineered with APG to demonstrate the functionality.
In this scenario, process noise is activated and limit values and infeeds are altered
so that messages can be monitored in the two APG process pictures (Level 1 and
Level 2).
Process noise for the jacket temperature and the reactor fill level is already
activated when the plant is started up. Activating the noise on the "AddNoise" block
provides a noise signal to the polymer density, melt flow index, H2 concentration,
C4 concentration; C2 concentration and the polymer temperature. If you wish to set
a stronger noise signal, you can set a larger value with the "StdDev"parameter in
the noise blocks in the "Sim_Reactor" chart. Noise that is too great, e.g., when
operating point optimization with a multi-variable controller is activated, has an
influence on product quality as well as on control behavior. Depending on the
deviation, it may be necessary to adjust the tolerance ranges for the operating
points. If the fluctuations in several process variables are too great, the process will
no longer be controllable.

Table 5-4

No. Action

1.  Switch to the SIMATIC Manager plant view and openthe "Presettings" CFC in the path
"UT_PolyReactor_MP > UT_PolyReactor_AS > Reactor > PolyReactor> Process >
Presettings".

2.  Activate the test CPU from the "Debug > TestMode" menu item.
3.  Activate the display of all parameters in the "AddNoise" block and assign the value "1" to the

"In1" parameter.
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No. Action

4.  In the OS, switch to the "Reactor" process picture and open the limit value settings in the
faceplate for the "Cat. Prod" measuring point.

5.  Set a lower lower warning limit of "290" and an alarm limit of "250".
6.  Open the faceplate for the "FIC_Monomer" measuring point.

7.  Change the setpoint specification to internal and assign a new flow rate value of "2900".
Note
Even the flow rate of solvent (diluent) is reduced as it is supplied in proportion to the
monomer.
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Evaluation
By changing the flow volume, less monomer is supplied than is preset in the
optimum working range. In addition, due to the ratio control even less solvent
(diluent) is supplied to the reactor, which results in a temporary reduction in the fill
level. The fill level controller corrects the disturbance variable with a lag. Due to the
changed ratio of polymer density x polymer discharge to catalyst inflow, the level
will be below the two set limits (alarm and warning) until the value settles in the
region of "267", within the lower warning limit.
The following representation shows the changes to the two process pictures,
"Reactor" and "Plant". The optimum process status can be seen on the left, while
the effects of the inflow change can be recognized in the right hand process
picture.

Figure 5-2

1. In the spider diagram in the "Plant" process picture, the effect of the catalyst
productivity falling below the warning limit is represented by a yellow bar.
Furthermore, from the polygon connection it can be recognized that the
monomer flow rate is outside the working range.

2. In the "Reactor" process picture, the vertical green arrow pointing down
indicates that the monomer flow rate has fallen below the display range. Alarm
and warning limits are not set for the flow rates.
The yellow measurement display, the yellow flashing "W" symbol and the
yellow warning limit in the bar graph indicate that the catalyst productivity has
fallen below the lower warning limit.
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6 Literature
6.1 Related documents

This list is by no means complete and merely reflects a selection of suitable
literature.
Table 6–1

Subject area Title
/1/ Practical manual for controllers

with SIMATIC S7 and SIMATIC
PCS7 for process automation

Controlling with SIMATIC
Müller, Jürgen / Pfeiffer, Bernd-Markus /
Wieser, Roland
Publicis Kommunikationsagentur
ISBN 978-3895783401

6.2 Internet links
Table 6-2

Subject area Title

\1\ Siemens Industry Online Support https://support.industry.siemens.com/

\2\ Article download page https://support.industry.siemens.com/cs/ww/
en/view/84061788

\3\ SIMATIC PCS 7 overview (collection of
links for FAQ, manuals, compendium,
forum, application examples and
videos)

https://support.industry.siemens.com/cs/ww/
en/view/63481413

\4\ Controller optimization with the PID
Tuner

https://support.industry.siemens.com/cs/ww/
en/view/8031495

\5\ Equipment Modules for PCS 7 using the
example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/
en/view/53843373

\6\ PCS 7 Unit Template "Stirred Tank
Reactor" using the example of the
Chemical industry

https://support.industry.siemens.com/cs/ww/
en/view/60546560

\7\ PCS 7 Unit Template "Fermenter" using
the example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/
en/view/68098270

\8\ PCS 7 Unit Template "Distillation
Column" using the example of the
Chemical Industry

https://support.industry.siemens.com/cs/ww/
en/view/48418663

\9\ PCS 7 Unit Template "Dryer" using the
example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/
en/view/74747848

\10\ How do you procure documentation for
PCS 7 V8.0 (including the PCS 7 V8.0
Manual Collection)?

https://support.industry.siemens.com/cs/ww/
en/view/59538371

\11\ Integration of Advanced Process
Graphics in SIMATIC PCS 7

https://support.industry.siemens.com/cs/ww/
en/view/89332241

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/84061788
https://support.industry.siemens.com/cs/ww/en/view/84061788
https://support.industry.siemens.com/cs/ww/en/view/63481413
https://support.industry.siemens.com/cs/ww/en/view/63481413
https://support.industry.siemens.com/cs/ww/en/view/8031495
https://support.industry.siemens.com/cs/ww/en/view/8031495
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/60546560
https://support.industry.siemens.com/cs/ww/en/view/60546560
https://support.industry.siemens.com/cs/ww/en/view/68098270
https://support.industry.siemens.com/cs/ww/en/view/68098270
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/view/74747848
https://support.industry.siemens.com/cs/ww/en/view/74747848
https://support.industry.siemens.com/cs/ww/en/view/59538371
https://support.industry.siemens.com/cs/ww/en/view/59538371
https://support.industry.siemens.com/cs/ww/en/view/89332241
https://support.industry.siemens.com/cs/ww/en/view/89332241
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7 History
Table 7–1

Version Date Change

V1.0 04/2014 First edition
V1.1 05/2014 New chapter 3.13 and 5.4 added
V1.2 09/2015 Update for PCS 7 V8.1
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